


Contents

Welcome to OS/2 Integration Tools Help

Choose from the following topics for more information:
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Installing Under Win-OS/2
PerfectOffice for Windows Folder
Tips and Tricks
Workplace Shell Integration



Subdocument
A subdocument is a document linked to a master document.    When a master document is 
expanded, the linked subdocuments are retrieved into the master document.



QuickLaunch
QuickLaunch preloads a Windows session to allow WordPerfect 6.x for Windows to run faster.

QLWIN supports the following command line switches:

Switch Command
/wpc=<directory> used to specify the location of the shared code DLLs.    If this option 

isn't specified, the directory specified by the \WPConfig\SHWin2X\
Preferred entry in REG.DAT is used

/wpcnt used when the shared code directories are located on the network.
"0" specifies that the shared code DLLs should not be loaded at all. 
This option is normally used when a server install (of any 
application) exists.    In order to allow the "WPCNET Settings" and 
"WPCNET Flagging" icons to load the proper BIF file, shared code 
cannot be loaded at all when they are executed.

"1" through "60" specifies that QuickLaunch should periodically 
(every 1-60 seconds, depending on the parameter) check for the 
existence of the shared code DLLs.    Once they exist, they should 
be loaded.    This option is normally used when a workstation install 
(of any application) exists.    Because QuickLaunch is normally 
loaded BEFORE a user logs on to the network, QuickLaunch needs 
to periodically check to see if the user has logged onto the 
network.    Once the user has logged on, the shared code DLLs can 
be loaded.

If this option is not specified at all, and the shared code DLLs 
cannot be located, QuickLaunch will immediately shutdown.



Shared Applications Folder

The Shared Applications folder contains the following programs and folders:

Automatic Document Detection Utility
Grammatik
KickOff
OS/2 Integration Tools Setup (SETUPOS2.EXE)
QuickFinder File Indexer
QuickLaunch (only if it wasn't loaded into the Startup Folder)
Shared Applications README Folder
Spell Checker
Thesaurus

See Also
PerfectOffice for Windows Folder
WordPerfect 6.x for Windows Folder



PerfectOffice for Windows Folder

The PerfectOffice for Windows folder contains the folders for all installed PerfectOffice 
applications.    It also contains the Shared Applications folder.

See Also
Shared Applications Folder
WordPerfect 6.x for Windows Folder



WP Docs Folder

Purpose
Use WP Docs Folder to store your WordPerfect documents.

Steps
To access your WordPerfect files,
1 Open the PerfectOffice for Windows folder, open the WordPerfect 6.x for Windows folder,

then double-click the WP Docs Folder.

To save your WordPerfect files to the WP Docs Folder,
1 Choose Save from the File menu, type a name from the file in the Filename text box, 

then choose OK.

See Also
Drag and Drop Deleting
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics
Opening WordPerfect from the Document Object



Grammatik 6

Purpose
Use Grammatik 6 to check your WordPerfect documents for spelling, grammar, 
punctuation errors and style flaws.

Steps
To Open Grammatik 6,
1 Open the PerfectOffice for Windows folder, open the Shared Applications folder, then 

double-click the Grammatik 6 object.
2 If you want help on a Grammatik feature, choose Contents from the Grammatik Help 

menu.

See Also
Spell Check
Thesaurus



Options
The Install and Uninstall options are:

Option * Lets You
Place QuickLaunch icon in 
startup folder

Put the QuickLaunch icon in the startup folder (if not 
checked, QuickLaunch is placed in the Shared Applications 
Folder).

Add SET 
RESTARTOBJECTS=STARTUP
FOLDERSONLY to Config.Sys

Change the existing CONFIG.SYS file to start only those 
objects located in the Startup folder when OS/2 is first 
started.

Make backup copies of OS/2 
system files

Backup the CONFIG.SYS, OS2.INI, and OS2SYS.INI system 
files (.Wxx extension).

Destroy existing objects before 
recreating them

Destroy and recreate all objects from scratch.    It will also 
remove any objects that no longer exist on the hard disk.

* The Add SET RESTARTOBJECTS=STARTUPFOLDERSONLY to Config.Sys option is dimmed 
(not available) when Uninstall options are selected.



Uninstall
The File Locations list button (>>) will let you view your PerfectOffice directory locations.

The Uninstall Options button will let you select options that affect the Integration Tools 
uninstallation (the Add SETRESTARTOBJECTS=STARTUPFOLDERSONLY to Config.Sys option is 
dimmed (not available) when Uninstall options are selected.).



Install
The Install dialog box will list all available PerfectOffice applications.    There are four 
installation types:

1. Normal - Stand-alone install
2. Server - Network install
3. Workstation - Workstation install
4. None - No applications installed

The File Locations list button (>>) will let you change your PerfectOffice directory locations.

The Install Options button will let you select options that affect the Integration Tools 
installation.



Automatic Document Detection Utility

Purpose
Use the Automatic Document Detection (ADD) Utility to configure the way the ADD feature
works.    The ADD Utility lets you turn the feature on or off and lets you control whether 
extended attributes are written to non-WordPerfect file types.    In addition, you can use 
the ADD Utility to provide double-click to open and drag-drop printing features for 
document types without an OS/2 native application.

The ADD Utility automatically registers your WordPerfect 5.x and 6.x document types.

Steps
To register non-WordPerfect document formats,
1 Open the Shared Applications folder in the PerfectOffice for Windows folder, then 

double-click the ADD Utility icon.
2 Select a document type from the Available document types list box, then choose Add.
3 Choose OK.

See Also
Document Objects



OS/2 Integration Tools Setup (SETUPOS2.EXE)

Purpose
Use SETUPOS2.EXE to install the OS/2 Integration Tools files to your desktop.

Steps
1 Insert the OS/2 Integration Tools disk into drive A, double-click the Drive A object, then 

double-click the SETUPOS2.EXE icon.
2 Choose from the following options:

Option Lets You
Install Install OS/2 support for PerfectOffice applications
Uninstall Uninstall OS/2 support for PerfectOffice applications
README View product information not contained in current documentation

3 Follow the on-screen instructions for the option you chose.
4 Close the Drive A folder, then reboot when SETUPOS2.EXE has finished running.

To install the OS/2 Integration Tools disk to your desktop from the network,
1 Install the OS/2 Integration Tools files to the Server install on the network.
2 Go to the folder where shared code is installed on the network, then double-click the 

SETUPOS2.EXE icon.
3 Choose from the following options:

Option Lets You
Install Install OS/2 support for PerfectOffice applications
Uninstall Uninstall OS/2 support for PerfectOffice applications
README View product information not contained in current documentation

4 Follow the on-screen instructions for the option you chose.
5 Reboot when SETUPOS2.EXE has finished running.

The following four switches correspond to the checkboxes in the "Options" dialog box:
Switch Command
/fixwps destroys, then recreates all objects from scratch and will remove 

any objects that no longer exist on the hard disk.

This option works around a known OS/2 problem in the object 
installation and has been reported to IBM.

/norestartobjects does not add SET RESTARTOBJECTS=STARTUPFOLDERSONLY to 
your config.sys file.

/noquicklaunch does not place QuickLaunch in the startup folder (it will be placed 
in the shared applications folder instead)

/nobackup does not create backup copies of config.sys, os2.ini, and os2sys.ini 
before installing / uninstalling

The following switches will cause the user interface to be skipped completely--the 
(un)installation will be started immediately.    Multiple instances of these switches can be 
used (i.e. "/i=wp6,s /i=wp6,w" to install server and workstation support at the same time):

Switch Command
/i=xxx,y install the workplace support for application xxx (currently only "WP6" is 



supported) and installation type y (N=normal, S=server, W=workstation)
/u=xxx,y uninstall the workplace support for application xxx and installation type y

See Also
Tips and Tricks
WordPerfect Setup (SETUP.EXE)



Document Summary Information

Purpose
Use WordPerfect Document Summary information to view and sort attributes in the 
Settings view of all WordPerfect 6.x for Windows objects.

Steps
To edit the document summary details,
1 Open the Settings page of a WordPerfect document object.
2 Type the new text you want into the Settings page (the changes will be automatically 

saved to the document).    The document summary can also be edited from WordPerfect 
6.x for Windows.

3 Close the Settings page.

The document summary details can be seen in the Details view of a folder object.    Refer 
to the help information provided on the following Settings notebook pages of any folder 
object for further information about how to display, sort by, and include by the document 
summary details:

  View (page 3 of 3)
  Include (WordPerfect 6.x Document Criteria page)
  Sort

            You must select WordPerfect 6.x Document in the Object type list box to activate the 
use of the document summary details.



Drag and Drop Deleting

Purpose
Use Drag and Drop Deleting to delete WordPerfect document objects without opening 
WordPerfect 6.x for Windows.

Steps
To delete a WordPerfect document object,
1 Open the folder containing the document object you want to delete.
2 Select the document object(s) you want to delete, drag the object(s) to the Shredder 

object, then release the mouse button.

See Also
Document Objects
Drag and Drop Colors
Drag and Drop Fonts
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics



Installing Under Win-OS/2

Purpose
Use SETUP.EXE and SETUPOS2.EXE to install the WordPerfect 6.x for Windows and the 
OS/2 Integration Tools files to your desktop.

Steps
To install WordPerfect 6.x for Windows from the disk set,
1 Insert the Install 1 (Setup) disk into drive A, then double-click the Drive A icon on the 

desktop.
2 Double-click the SETUP.EXE icon.
3 Follow the on-screen instructions.

            No application that uses WordPerfect shared code can be running while installing 
WordPerfect (including QuickLaunch).

To install WordPerfect 6.x for Windows from the network,
1 Go to the folder where the WordPerfect 6.x for Windows files are located, then double-

click the SETUP.EXE icon.
2 Follow the on-screen instructions.

            Network administrators should use OS/2 to copy WordPerfect to the network in order 
to ensure the extended attributes are copied to the network.

After WordPerfect 6.x for Windows is installed, use the following steps to install the OS/2 
Integration Tools files to your desktop.
1 Insert the OS/2 Integration Tools disk into drive A, double-click the Drive A object, then 

double-click the SETUPOS2.EXE icon.
2 Follow the on-screen instructions.
3 Close the Drive A folder, then reboot when SETUPOS2.EXE has finished running.

To install the OS/2 Integration Tools disk to your desktop from the network,
1 Install the OS/2 Integration Tools files to the Server install on the network.
2 Go to the folder where shared code is installed on the network, then double-click the 

SETUPOS2.EXE icon.
3 Follow the on-screen instructions.
4 Reboot when SETUPOS2.EXE has finished running.

See Also
OS/2 Integration Tools Setup (SETUPOS2.EXE)
Tips and Tricks
WordPerfect Setup (SETUP.EXE)



Associate OS/2 Printers with Windows Printers

Purpose
Use the Associate OS/2 Printers with Windows Printers dialog box to associate your 
Windows printer with your OS/2 printer.    This will let you use your OS/2 printer while in 
WordPerfect 6.x for Windows.

Steps
To associate your printers for the first time,
1 Drag and drop a WordPerfect document object to an OS/2 printer (the Associate OS/2 

Printers with Windows Printers dialog box appears).
2 Select the Windows printer you want to associate with the highlighted OS/2 printer, then

choose Associate.
or... If the correct Windows printer is not displayed, choose Windows Printer Options, 
add the correct printer definition, select the new printer definition, then choose 
Associate.

To associate your printer from the Select Printer dialog box,
1 Choose Print from the File menu, then choose Select.
2 Choose Options, then choose OS/2 Printers (you will only see the OS/2 Printers option 

while running WordPerfect under OS/2).
3 Select an OS/2 printer from the OS/2 Printers list box, select a Windows printer from the 

Associated Windows Printers list box, then choose Close.
4 You can use Delete Association to delete the associations for selected OS/2 printers (the

printer definitions are not deleted), or use Windows Printer Options to add, delete, or 
edit Windows printer definitions.

See Also
Document Objects
Drag and Drop Printing
Tips and Tricks
WordPerfect Printers Folder



Tips and Tricks

This Help screen will give you more information about the following topics:

  Settings Configuration
  Startup Commands
  Printing to the Network
  Possible Traps While Running in Win-OS/2
  Moving Your Desktop from HPFS to FAT

Settings Configuration
Running WordPerfect 6.x for Windows under OS/2 2.1 requires some configuration of the 
WordPerfect Program object's Settings notebook.    When you use SETUP.EXE to install the 
WordPerfect 6.x for Windows folder, these settings are changed automatically.    The 
following settings are changed in the Win-OS/2 settings dialog box on the Session tab:

Setting Name Default Suggested
WIN_RUN_MODE STANDARD ENHANCED
DOS_FILES 20 100
DOS_HIGH OFF ON
DPMI_DOS_API DISABLED ENABLED
DPMI_MEMORY_LIMIT 4 128
IDLE_SECONDS 0 5
IDLE_SENSITIVITY 75/95 95
XMS_MEMORY_LIMIT 2048 6144+
WIN_CLIPBOARD ON ON
WIN_DDE ON ON

Startup Commands

The following four switches correspond to the checkboxes in the Options dialog box:
Switch Command
/fixwps Destroys, then recreates all objects from scratch and will remove 

any objects that no longer exist on the hard disk.

This option works around a known OS/2 problem in the object 
installation and has been reported to IBM.

/norestartobjects Does not add SET RESTARTOBJECTS=STARTUPFOLDERSONLY to 
your CONFIG.SYS file.

/noquicklaunch Does not place QuickLaunch in the startup folder (it will be placed 
in the Shared Applications Folder instead).

/nobackup Does not create backup copies of CONFIG.SYS, OS2.INI, and 
OS2SYS.INI before installing / uninstalling.

The following switches will cause the user interface to be skipped completely--the 
(un)installation will start immediately.    Multiple instances of these switches can be used 
(i.e., "/i=wp6,s /i=wp6,w" to install server and workstation support at the same time):

Switch Command
/i=xxx,y Install the workplace support for application xxx (currently only "WP6" is 

supported) and installation type y (N=normal, S=server, W=workstation).
/u=xxx,y Uninstall the workplace support for application xxx and installation type y.



QLWIN supports the following command line switches:

Switch Command
/wpc=<directory> Used to specify the location of the shared code DLLs.    If this option

isn't specified, the directory specified by the \WPConfig\SHWin2X\
Preferred entry in REG.DAT is used.

/wpcnt Used when the shared code directories are located on the network.
"0" specifies that the shared code DLLs should not be loaded at all. 
This option is normally used when a server install (of any 
application) exists.    In order to allow the "WPCNET Settings" and 
"WPCNET Flagging" icons to load the proper BIF file, shared code 
cannot be loaded at all when they are executed.

"1" through "60" specifies that QuickLaunch should periodically 
(every 1-60 seconds, depending on the parameter) check for the 
existence of the shared code DLLs.    Once they exist, they should 
be loaded.    This option is normally used when a workstation install 
(of any application) exists.    Because QuickLaunch is normally 
loaded BEFORE a user logs on to the network, QuickLaunch needs 
to periodically check to see if the user has logged onto the 
network.    Once the user has logged on, the shared code DLLs can 
be loaded.

If this option is not specified at all and the shared code DLLs cannot
be located, QuickLaunch will immediately shut down.

Printing to the Network
If you are having difficulty printing from the LPTx printer port when using a network printer, 
try using the corresponding LPTx.OS2 printer port.

To use a LPTx.OS2 printer port with a WordPerfect printer driver, you must print to a file 
using the filename LPTx.OS2.

Possible Traps While Running in Win-OS/2
If you experience a trap in WordPerfect 6.x for Windows while running in seamless Win-OS/2 
mode and you are using the QuickLaunch feature, you may end up with some WordPerfect 
6.x open view entries in your Window List that cannot be closed.    The operating system has 
not told the OS/2-Win-OS/2 communication mechanism that the WordPerfect 6.x for Windows
application is no longer running.    This problem has been reported to IBM.

You can resolve this problem by closing down all of your seamless Win-OS/2 applications, 
then closing down the QuickLaunch application.    This will shut down the seamless Win-OS/2 
session completely.    Once the seamless Win-OS/2 session has terminated, your system 
should be back to normal.

Moving Your Desktop from HPFS to FAT
When running any Windows application in Win-OS/2 mode under OS/2 version 2.x, it is 
important to choose a disk format that will enable that application to run to the best of its 
ability.

With the FAT file system, all filenames and directory names have a maximum length of eight 
characters with a three-character extension (for example, FILENAME.EXT).

With the HPFS file system, any filename or directory name can be as long as 254 characters 
with more than three characters in the extension.



Any Windows or DOS application you run under OS/2 version 2.x will only be able to use files
with standard DOS filenames (as many as eight characters with a maximum three-character 
extension).    Any files with HPFS long names will be hidden from your Windows and DOS 
applications, including all files with long subdirectory names.

Steps
To move your OS/2 desktop from one disk partition to another without having to reinstall 
the operating system,
1 Make sure you are using OS/2 version 2.1 or later.
2 Double-click the OS/2 System folder.
3 Double-click the Drives folder within the OS/2 System folder.
4 Double-click the disk object where you installed OS/2 (C: by default).
5 Look for your desktop directory in the tree hierarchy for that disk.    It should be called 

Desktop or OS!2 2.0 Desktop and have an office desk icon.
6 Once you find the desktop object, drag it to a FAT disk partition.
7 While your desktop is moving, do not reboot or open other objects. Once the move is 

complete, wait a few seconds while OS/2 writes all desktop link information back to your
hard disk.



Templates

Purpose
Use templates to quickly create professional-looking newsletters, envelopes, fax cover 
sheets, letters, memos, and more.

Steps
To use a document template,
1 Open the PerfectOffice for Windows folder, open the WordPerfect 6.x for Windows folder,

then double-click the WordPerfect Templates folder.
2 Select the appropriate template, then drag the template to another folder or to your 

desktop.

WordPerfect will open with the template in the document window.    The template will 
prompt you for information (for example, your name and phone number).    After you enter
the information once, the template will automatically merge this information into any 
template subsequently opened.

See Also
Document Objects
Opening WordPerfect from the Document Object
Templates Folder



WordPerfect 6.x for Windows Folder

Purpose
The WordPerfect 6.x for Windows Folder contains the following WordPerfect 6.x for 
Windows objects and folders:

Graphics Folder
Readme Folder
Templates Folder
WordPerfect 6.x for Windows Object
WordPerfect Printers Folder
WordPerfect Setup
WP Docs Folder

Steps
To run a WordPerfect program or open a WordPerfect folder,
1 Double-click the program object or folder.

To access help for each object located in this folder,
1 Select the object, then press F1.

or... Select Help from the object's context menu.

See Also
PerfectOffice for Windows Folder
Reinstalling the WordPerfect 6.x for Windows Folder
Shared Applications Folder
WordPerfect Workspace



WordPerfect Workspace

Purpose
Use the WordPerfect Workspace template to create work area folders ready to hold your 
WordPerfect documents.    A Workspace folder will open by default into Details view with 
the WordPerfect document details (Author, Typist, and so on) selected.

Steps
To use the WordPerfect Workspace template,
1 Open the PerfectOffice for Windows folder, open the WordPerfect 6.x for Windows folder,

then double-click the Templates folder.
2 Select the WordPerfect Workspace template, then drag and drop the template to 

another folder or your desktop.
3 Open the new Workspace folder by double-clicking it.    Note that it opens into Details 

view by default.

See Also
Templates
Templates Folder



Workplace Shell Integration

WordPerfect 6.x for Windows integrates with the Workplace Shell in a seamless fashion.    
Choose from the following topics below for more information about the Workplace Shell 
features in WordPerfect.
 
Associate OS/2 Printers with Windows Printers
Automatic Document Detection Utility
Document Objects
Document Summary Information
Drag and Drop Colors
Drag and Drop Deleting
Drag and Drop Fonts
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics
Opening WordPerfect from the Document Object
Templates
WordPerfect Workspace



Document Objects

Purpose
A document object is a graphical representation of a saved document.    You can use the 
WordPerfect document objects from the Workplace Shell to open, print, and delete 
documents, databases, graphics, and spreadsheets.

If a WordPerfect document was not created in WordPerfect 6.x for Windows, it will 
automatically be converted into a WordPerfect 6.x document object the first time the 
folder containing the document is opened.    You can use the Automatic Document 
Detection Utility to convert files from other word processing programs into document 
objects.

Steps
To select a document object,
1 Click the document object with the left mouse button.

To select more than one document object,
1 Click the first document object with the left mouse button.
2 Hold down the Ctrl key, then select the next document object with the left mouse 

button.
3 Repeat step 2 until all document objects are selected.

To drag the document object(s),
1 Select the object(s), press and hold the right mouse button, then move the object(s) to 

the desired location. 

See Also
Automatic Document Detection Utility
Drag and Drop Deleting
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics
Opening WordPerfect from the Document Object



Help Topic Titles

Associate OS/2 Printers with Windows Printers
Automatic Document Detection Utility
BIF Editor
Document Objects
Document Summary Information
Drag and Drop Colors
Drag and Drop Deleting
Drag and Drop Fonts
Drag and Drop Printing
Grammatik
Graphics Folder
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics
Installing Under Win-OS/2
KickOff
Opening WordPerfect from the Document Object
OS/2 Integration Tools Setup (SETUPOS2.EXE)
PerfectOffice for Windows Folder
QuickFinder File Indexer
QuickLaunch
README Folder
Reinstalling the WordPerfect 6.x for Windows Folder
Shared Applications Folder
Spell Checker
Templates
Templates Folder
Thesaurus
Tips and Tricks
WordPerfect 6.x for Windows Folder
WordPerfect 6.x for Windows Object
WordPerfect Printers Folder
WordPerfect Workspace
WP Docs Folder
WordPerfect Setup (SETUP.EXE)



Graphics Folder

Purpose
The Graphics folder contains predefined WordPerfect graphics.

Steps
To use a graphic from the WordPerfect Graphics folder,
1 Double-click the WordPerfect Graphics folder, then select the appropriate graphic.
2 Choose from the following topics for more information:

Drag and Drop Printing
Inserting Spreadsheets, Databases, and Graphics
Opening WordPerfect from the Document Object

See Also
WordPerfect 6.x for Windows Folder



Templates Folder

Purpose
The WordPerfect Templates folder contains over 70 templates for newsletters, envelopes, 
fax cover sheets, letters, memos, and more.    Templates are automated and will prompt 
you for necessary information (for example, your name and phone number).

Steps
To open the Templates folder,
1 Open the PerfectOffice for Windows folder, open the WordPerfect 6.x for Windows folder,

then double-click the Templates folder.

See Also
Templates
WordPerfect 6.x for Windows Folder



WordPerfect Printers Folder

Purpose
The WordPerfect Printers folder contains printer objects for all WordPerfect printer drivers 
found in your private and public .BIFs, and all Windows drivers found in your public .BIF.    
The WordPerfect Printers folder is updated each time WordPerfect is invoked.

Windows drivers located in your private .BIF are automatically mapped to the nearest 
compatible OS/2 printer driver using the Associate OS/2 Printers with Windows Printers 
dialog box.

You can move printer objects out of the WordPerfect Printers folder or create a shadow of 
the printer object.    Printers are permanently added or deleted from your WordPerfect 
Printers folder as you add and delete printer definitions from the Select Printer dialog box 
in WordPerfect.

Steps
To open the WordPerfect Printers folder,
1 Open the PerfectOffice for Windows folder, open the WordPerfect 6.x for Windows folder,

then double-click the WordPerfect Printers folder.

            If you delete the WordPerfect Printers folder, all printer objects found in your private 
and public .BIFs will appear on the desktop each time WordPerfect is invoked.    If the 
WordPerfect Printers folder is deleted, you must use SETUPOS2.EXE to restore it.

See Also
Associate OS/2 Printers with Windows Printers
Drag and Drop Printing
OS/2 Integration Tools Setup (SETUPOS2.EXE)
Reinstalling the WordPerfect 6.x for Windows Folder



Spell Checker

Purpose
Use Spell Checker to check your document for misspelled words, two occurrences of a 
word in a row, and certain types of capitalization errors. You can check a word, page, 
document, or selected text.

You can also look up words phonetically or display all the words in the dictionary that 
match a pattern.

Steps
To open the WordPerfect Spell Checker,
1 Open the PerfectOffice for Windows folder, open the Shared Applications folder, then 

double-click the Spell Checker object to start WordPerfect Spell Checker.
or... Choose Spell Checker from the Tools menu while in WordPerfect.

Spell Checker is a stand-alone application, which means you can run it under Win-OS/2 
without running WordPerfect.    When you run it in stand-alone mode, you can only look 
up words--you cannot spell-check a document.

See Also
Grammatik
Shared Applications Folder
Thesaurus



Thesaurus

Purpose
Use Thesaurus to search for and display synonyms (words with the same or similar 
meaning) and antonyms (words with the opposite meaning) of words in your text or words 
you type from the keyboard.

Steps
To open WordPerfect Thesaurus,
1 Open the PerfectOffice for Windows folder, open the Shared Applications folder, then 

double-click the Thesaurus object to start WordPerfect Thesaurus.
or... Choose Thesaurus from the Tools menu while in WordPerfect.

Thesaurus is a stand-alone application, which means you can run it under Win-OS/2 
without running WordPerfect.    When you run it in stand-alone mode, you can only look up 
words--you cannot use it with a document.

See Also
Grammatik
Shared Applications Folder
Spell Checker



KickOff

Purpose
Use KickOff to automatically start any program at a certain time during the day.

Steps
To set up KickOff,
1 Open the PerfectOffice for Windows folder, open the Shared Applications folder, double-

click the KickOff object, then choose Add.
2 Type the path and program name of the program you want to automatically start.

or... Choose Browse, select the directory and filename of the program you want to 
automatically start, then choose OK.

3 Enter the date and time the program will first begin in the Start Time group box.
4 If desired, enter the time for the program to be opened again in the Repeat Interval 

group box. 
5 Choose OK.

To run KickOff,
1 Double-click the KickOff object.

or... Copy the KickOff object to the Startup folder and KickOff will run every time you 
start OS/2.

See Also
Shared Applications Folder



Drag and Drop Colors

Purpose
Use your OS/2 Color Palette to change text colors in your WordPerfect document.

Steps
1 Select the text you want to color.

or... Place the insertion point where you want the color change to begin.
2 Open the OS/2 Color Palette, then select a color.
3 Drag the color to the WordPerfect document window, then release the mouse button.
4 Close the OS/2 Color Palette.

See Also
Document Objects
Drag and Drop Deleting
Drag and Drop Fonts
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics



Drag and Drop Printing

Purpose
Use Drag and Drop Printing to print a WordPerfect document without opening WordPerfect 
6.x for Windows. 

Steps
1 Open the folder containing the document object you want to print.
2 Select the document object, drag the object to a printer object, then release the mouse 

button.

WordPerfect 6.x is a Windows application.    To print from a Windows application using an 
OS/2 printer object, an OS/2 printer must be associated with a Windows printer.    The 
Associate OS/2 Printers with Windows Printers dialog box will automatically appear the 
first time you drop a WordPerfect object on an OS/2 printer.

See Also
Associate OS/2 Printers with Windows Printers
WordPerfect Printers Folder



Inserting a Document

Purpose
Use this feature to insert one or more document(s) into a new document window or into 
the current document.

Steps
1 Place the insertion point at the location you want the document(s) to be inserted.
2 Select the document object(s) you want to insert.
3 Drag the object(s) to your document, then release the mouse and key(s).

Use the following mouse and keystroke commands to change the way a document is 
inserted.

Mouse and Keystrokes Result
Drag and Drop Inserts the document into a new WordPerfect 

document window
Ctrl+Drag and Drop Inserts the document into the current document
Ctrl+Shift+Drag and Drop Inserts a subdocument link into the current 

document

See Also
Document Objects
Inserting Spreadsheets, Databases, and Graphics



Inserting Spreadsheets, Databases, and Graphics

Purpose
You can insert a spreadsheet, database, or graphic into a WordPerfect document by 
dragging and dropping the spreadsheet, database, or graphic onto a WordPerfect 
document window.

Steps
1 Place the insertion point at the location you want the spreadsheet, database, or graphic.
2 Select the spreadsheet, database, or graphic object you want to insert.
3 Drag the object to your document, then release the mouse and key(s).
4 Select the Data Type, select the Data Configuration (Import As), then choose OK.

Use the following mouse and keystroke commands to change the way a document is 
inserted.

Mouse and Keystrokes Result
Drag and Drop Inserts the spreadsheet, database, or graphic into a 

new WordPerfect document window
Ctrl+Drag and Drop Inserts the spreadsheet, database, or graphic into 

the current document
Ctrl+Shift+Drag and Drop Inserts a data-link to the spreadsheet, database, or 

graphic (in the current document)

See Also
Inserting a Document



Opening WordPerfect from the Document Object

Purpose
Use the document object to open WordPerfect with the document in the document 
window. 

Steps
1 Double-click the object.

or... Drag and drop the document object to the WordPerfect 6.x for Windows object.

See Also
Document Objects
Inserting a Document



Drag and Drop Fonts

Purpose
Use your OS/2 Font Palette to change the font in your WordPerfect document.

Steps
1 Select the text you want to change.

or... Place the insertion point where you want the font change to begin.
2 Open the OS/2 Font Palette, then select a font.
3 Drag the font to the WordPerfect document window, then release the mouse button.
4 Close the OS/2 Font Palette.

            If you wish to use the drag-drop font feature, you must first install your ATM fonts in 
the Win-OS/2 environment.    Do this using the ATM Control Panel icon located in the 
Main folder (OS/2 for Windows) or the Win-OS/2 Main folder (OS/2 full version).

See Also
Document Objects
Drag and Drop Colors
Drag and Drop Deleting
Drag and Drop Printing
Inserting a Document
Inserting Spreadsheets, Databases, and Graphics



Reinstalling the WordPerfect 6.x for Windows Folder

Purpose
Use the Destroy existing objects before recreating them feature in SETUPOS2.EXE to 
reinstall the WordPerfect 6.x for Windows folder to the desktop.

Steps
To reinstall the WordPerfect 6.x for Windows folder, 
1 Insert the OS/2 Integration Tools disk into drive A, double-click the Drive A object, then 

double-click the SETUPOS2.EXE icon.
2 Choose Install, then choose Options.
3 Select the Destroy existing objects before recreating them option, then choose OK.
4 Close the Drive A folder, then reboot when SETUPOS2.EXE has finished running.

See Also
WordPerfect 6.x for Windows Folder



BIF Editor

Purpose
Use the BIF Editor to edit binary initialization files.

Steps
To open the BIF Editor,
1 Open the PerfectOffice for Windows folder, open the WordPerfect 6.x for Windows Setup 

folder, then double-click the BIF Editor icon (WPCNET Flagging).

            The WordPerfect 6.x for Windows Setup folder and BIF Editor icon will only appear if 
Server Install was used when installing WordPerfect.

For further information about using the BIF Editor, 
1 Open the BIF Editor, then choose How Do I from the Help menu.



***Deleted topic***



QuickFinder File Indexer

Purpose
Use QuickFinder to create, edit, search, or update directory and file indexes.    Use 
QuickFinder when you need to find a particular word or phrase quickly.

Steps
To open QuickFinder,
1 Open the PerfectOffice for Windows folder, then open the Shared Applications folder.
2 Double-click the QuickFinder File Indexer object.

QuickFinder is a stand-alone application, which means you can run it under Win-OS/2 
without running WordPerfect.

See Also
PerfectOffice for Windows Folder
Shared Applications Folder



Readme Folder

Purpose
Use the Readme folder to get information about an application or folder that wasn't 
available when the Reference, User's Guide, or online Help was published.

Steps
To view a Readme file,
1 Open the Readme folder, then double-click the appropriate Readme document object.

See Also
Shared Applications Folder
Tips and Tricks
WordPerfect 6.x for Windows Folder



WordPerfect 6.x for Windows Object

Purpose
Use the WordPerfect 6.x for Windows object to start WordPerfect 6.x for Windows.

Steps
To open WordPerfect,
1 Open the PerfectOffice for Windows folder, then open the WordPerfect 6.x for Windows 

folder.
2 Double-click the WordPerfect 6.x for Windows object.

See Also
WordPerfect 6.x for Windows Folder



WordPerfect Setup (SETUP.EXE)

Purpose
Use SETUP.EXE to install or uninstall all or part of the WordPerfect 6.x for Windows 
program.

Steps
1 Open the PerfectOffice for Windows folder, open the WordPerfect 6.x for Windows folder,

then double-click the WordPerfect Setup icon.
2 Choose Install, then choose an option from the Installation Type group box.

or... Choose Uninstall, then choose an option from the Installation Type group box.

            Use the SETUPOS2.EXE uninstall feature to uninstall the OS/2 Integration Tools files.

See Also
Installing Under Win-OS/2
WordPerfect 6.x for Windows Folder



QuickLaunch

Purpose
Use QuickLaunch to preload a Windows session to allow PerfectOffice applications to run 
faster.

QLWIN supports the following command line switches:

/wpc=<directory>    used to specify the location of the shared code DLLs.    If this option 
isn't specified, the directory specified by the \WPConfig\SHWin2X\Preferred entry in 
REG.DAT is used.

/wpcnt    used when the shared code directories are located on the network.
"0" specifies that the shared code DLLs should not be loaded at all.    This option is 
normally used when a server install (of any application) exists.    In order to allow the 
"WPCNET Settings" and"WPCNET Flagging" icons to load the proper BIF file, shared code
cannot be loaded at all when they are executed.

"1" through "60" specifies that QuickLaunch should periodically (every 1 60 seconds, 
depending on the parameter) check for the existence of the shared code DLLs.    Once 
they exist, they should be loaded.    This option is normally used when a workstation 
install (of any application) exists.

Because QuickLaunch is normally loaded before a user logs on to the network, 
QuickLaunch needs to periodically check to see if the user has logged onto the network.    
Once the user has logged on, the shared code DLLs can be loaded.

            If this option is not specified at all, and the shared code DLLs cannot be located, 
QuickLaunch will immediately shutdown.

See Also
Shared Applications Folder




